
 

 

 

 

 

  

CS Odessa 

Getting Started with 
ConceptDraw MINDMAP v7 
for Mac OS 
 

 



 
 

Page | 2 Getting Started with ConceptDraw MINDMAP v7 ©CS Odessa, August 2011 

CONTENTS 
GETTING STARTED WITH ConceptDraw MINDMAP ................................................................................................................ 3 

CREATING MIND MAPS ........................................................................................................................................................... 4 

ADDING DETAILS ..................................................................................................................................................................... 5 

TOPIC TYPES ............................................................................................................................................................................ 6 

PRESENTING YOUR MIND MAP ............................................................................................................................................... 7 

BRAINSTORM MODE ............................................................................................................................................................... 8 

INPUTS & OUTPUTS ................................................................................................................................................................ 8 

WORKING WITH OTHER APPLICATIONS .................................................................................................................................. 9 

SOLUTION PARK ...................................................................................................................................................................... 9 

NO-CHARGE SUPPORT ............................................................................................................................................................ 9 

CROSS-PLATFORM LICENSING ................................................................................................................................................ 9 

OS X LION SUPPORT ................................................................................................................................................................ 9 

MULTI-DISPLAY SUPPORT ....................................................................................................................................................... 9 

MULTI-LANGUAGE SPELLCHECK ............................................................................................................................................. 9 

ABOUT CS ODESSA .................................................................................................................................................................. 9 

Technical Support/Sales Phone Numbers ........................................................................................................................... 9 

FREQUENTLY ASKED QUESTIONS .......................................................................................................................................... 10 

TABLE OF FIGURES ................................................................................................................................................................ 11 

INDEX .................................................................................................................................................................................... 11 

KEYBOARD SHORTCUTS ........................................................................................................................................................ 12 

 

  



 
 

Page | 3 Getting Started with ConceptDraw MINDMAP v7 ©CS Odessa, August 2011 

GETTING STARTED WITH ConceptDraw MINDMAP 
Thank you for your interest in ConceptDraw® MINDMAP v7! Let’s begin by installing the program on your system. 

To install the product, and activate your trial license:  

1. Navigate your web browser to www.ConceptDraw.com and click Join Us. 

 

Figure 1: Creating a new account on ConceptDraw.com 

2. Fill in the form with your information, and then click Submit. 

3. Check your email for the message from support@ConceptDraw.com that contains your confirmation link. (Spam 
filters may catch this message. If you don’t see the email within a few minutes, check your “Junk” or “Spam” 
folders.)  

4. Follow the link to confirm your account, and then click Proceed to installation. 

5. Click Download All ConceptDraw Products or Solutions. 

 

Figure 2: Downloading ConceptDraw Office Trial 

6. Once the download is complete, run the installation file. 

7. Follow all on-screen instructions to complete the installation. 

http://www.conceptdraw.com/
mailto:support@conceptdraw.com
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8. Once the program is installed and launched, you will be prompted to enter your ConceptDraw account 
information. Do so. 

9. Wait briefly for your account to be synchronized.  

10. Congratulations! Your FREE 21-day trial of ConceptDraw MINDMAP has begun. 

CREATING MIND MAPS 
Mind mapping is a method of organizing your thoughts visually that breaks the mold of old fashioned note taking. Mind 
mapping gets your thoughts onto the page organically, allowing ideas to stem from one another as they occur. The first 
step to creating a mind map is identifying its Main Idea. This central topic defines the map, creating a hub that 
subsequent Topics and Subtopics will all support. Think of it as the title of your map. 

 

Figure 3: Labeling the Main Idea 

Select the Main Idea tile with your mouse, and then type on your keyboard to label it. Press “Enter” when you’re 
finished labeling, then press “Enter” again to create your first Topic. 

 

Figure 4: Labeling a Topic 
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To label a Topic, select it with your mouse, and then simply type on your keyboard. Press “Return” to create another 
topic at the same level. To close the topic without creating a new one, press “Enter”. To create a Subtopic, highlight a 
Topic and press “Insert.” 

 

Figure 5: Labeling Subtopics 

Reorganizing your map is as simple as selecting a topic with your mouse, and then dragging and dropping it to a new 
location. You can promote and demote topics easily—just drag-and-drop a topic onto another topic to automatically 
subordinate it. Selected topics can also be deleted entirely by pressing “Delete” on your keyboard, or cut, copied, and 
pasted with familiar keyboard shortcuts.  

ADDING DETAILS 
It’s best to keep your individual topics concise. Mind maps with long winded topics quickly become cluttered, confusing, 
and ineffective. That being the case, the most impressive features of ConceptDraw MINDMAP are those that let you add 
more information to your mind map without interfering with its readability.  

You can add Notes can to a topic by selecting it with your mouse, and then clicking the Topic Content button on the 
toolbar. A Note Pane will appear in which you can type your Note, and a Note icon will then appear on the topic’s tile. 
Hover your mouse over the icon to view your Note’s text; otherwise, Notes are not displayed in the main view of your 
map. Click the Topic Content button on the toolbar again to toggle the Note Pane’s visibility. 

 

Figure 6: Adding Notes 

You can provide visual shortcuts for navigating your map with Symbols and Clipart. To add Symbols to a topic, select it, 
and then click the Inspector button on the toolbar. The Inspector Pane will appear; on it, select the Symbols tab. From 
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there, you can add a variety of recognizable symbols to your topics for indicating the status of tasks, resources, and 
decisions. To add Clipart, select a topic, and then from the menu bar at the top of the screen select Insert>  Picture> 
From Clipart.  

 

Figure 7: Adding Symbols 

Hyperlinks can also be embedded in a mind map to make referencing outside information quick and easy. Select a topic, 
and then click the Hyperlink button on the toolbar, or select the Hyperlink tab on the Inspector pane. Then choose the 
kind of hyperlink you want and enter its location in the box provided. To follow the link, click “Open” in the Hyperlinks 
pane, or simply click the Hyperlink icon that appears on the topic’s tile. 

 

Figure 8: Adding Hyperlinks 

TOPIC TYPES 

Specifying Topic Types for your topics enables an even deeper level of functionality in ConceptDraw MINDMAP. Select a 

topic in your map and then click the Inspector button to open the Inspectors, and then select the Topic Type pane. Topic 

Types are grouped in three areas: Universal Diagramming (a catch-all category for a basic Topic Type functionality), 

Business Productivity (useful in process mapping and risk analysis), and Project Management. The Project Management 

area contains all the Topic Types necessary to integrate your mind map with ConceptDraw PROJECT, such as Task, Phase, 
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Resources, and Milestones. Once you have selected a Topic Type, you can edit the corresponding Topic Content. Click 

the Topic Content button on the toolbar (or select the tab on the Inspector pane) to view the Topic Data pane. 

Depending on the selected Topic Type, you have a variety of options such as attaching Documents, setting dates for 

Tasks, and identifying costs of Resources. By utilizing Topic Types, you can organize a vast amount of data in a single file 

that’s easily deciphered.  

 

Figure 9: Topic Type Inspector 

PRESENTING YOUR MIND MAP 

With its built-in Presentation Mode, ConceptDraw MINDMAP makes generating presentations faster and easier than 
ever before. The Presentation menu houses all your presentation controls in a single, convenient location.  

 

Figure 10: Presentation menu 

To begin presenting with zero prep time, simply click Start Presentation. A basic slideshow highlighting each of your 
Main Topics will begin in full-screen Presentation Mode. Click the mouse to advance slides.  

Create Default Presentation stores the default slideshow in the Slide Navigator without engaging Presentation Mode. 
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The Create Slide submenu houses controls for customizing your presentation. Set to Visible captures a slide of the area 
of your map currently in view. Using the Zoom controls on the View menu of the ribbon, you can focus on specific areas 
of your map, and quickly create slides of only the content you want.  

Set to Selected captures a slide of the selected topic or topics. Set to Selected with Subtopics allows you to select a 
topic and capture a slide of it and its related subtopics with a single click.     

Show Slide Navigator expands the Slide Navigator tray at the bottom of the window. In the Slide Navigator, you will see 
all the slides you have created. You can reorder them by dragging and dropping, or remove them by clicking the X in 
their upper-right corner. Clicking the large plus icon works just like Set to Visible. Clicking the play icon in the upper-left 
corner of a slide begins presentation mode from that slide.  

Beyond its own presentation mode, ConceptDraw MINDMAP can also export to Microsoft® PowerPoint®. Selecting 
Export to MS PowerPoint opens a window with two options: Outline and Slideshow. Outline exports just the text of 
your map, allowing you to select from your available PowerPoint themes for the presentation. Slideshow exports the 
images saved in your Slide Navigator as the slides of a new MS PowerPoint presentation. 

The Export to Pictures menu item saves the slides in your Slide Navigator as graphics files in a new folder. A variety of 
popular graphics formats are available when exporting your presentation. 

Send Presentation opens a new message in your email client with your map’s outline as the text, and attaches both your 
map file and a .png file exported from your map. The attached map file is saved in Presentation mode. When the 
recipient opens it, they will view the presentation you have created. 

BRAINSTORM MODE 
Brainstorming is a great way to begin a new map or to expand an existing map, allowing you to add a large amount of 
ideas and data to your map very quickly. To begin brainstorming, click the Brainstorm button on the toolbar. 

 

Figure 11: Brainstorm button 

If this is a new map, first, name your main topic.  If you want to set a time limit for your Brainstorming session, enter the 
amount of time desired, and then click Start Timer. When you are ready to begin brainstorming, click on the Enter Ideas 
field and begin typing out your brainstormed ideas.  After you finish each idea, press Enter on your keyboard to add it to 
the map.  Repeat until you are finished brainstorming. Don’t worry about the structure of your list; you’ll organize it 
after the Brainstorm. When you are finished brainstorming, just drag and drop your ideas to connect them to other 
topics.   

INPUTS & OUTPUTS 

Select Input from the File menu to view a variety of templates designed to inspire your creativity and help you get 

started with mind mapping. The left-most pane of the Inputs window displays a list of categories; the center, the various 

examples in a selected category; and the right, a detailed description of a selected example. The Output window 

(accessible via File> Output) is set up similarly, with categories on the left, examples in the center, and description on 

the right. Outputs included mind maps of only certain Topic Types, as well as opening mind maps with ConceptDraw 

PROJECT for more detailed resource management, drawing ORG charts and other diagrams from your mind map with 
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ConceptDraw PRO, and a variety of other ready-to-use documents. Outputs are a powerful way to get your thoughts off 

the page and into action. 

WORKING WITH OTHER APPLICATIONS 

ConceptDraw MINDMAP has the ability to export to a number of usable file formats, giving ConceptDraw users powerful 
flexibility in working with others. Expand the File menu to view all of ConceptDraw MINDMAP’s import and export 
capabilities. Import options include OPML files, text outlines, Microsoft Project® native files (.mpp), and Mindjet® 
MindManager® files. Export options include MS Project and PowerPoint, as well as Adobe® PDF, HTML, and a variety of 
graphics formats.   

SOLUTION PARK 
ConceptDraw Solution Park is an ever-growing collection of business-specific solutions and product add-ons that are 
available to add continued value after the initial purchase of a ConceptDraw product. For more information, visit 
http://www.conceptdraw.com/solutions.php. 

NO-CHARGE SUPPORT 
CS Odessa offers no-charge support for all licensed and trial users of ConceptDraw Products.  ConceptDraw Maintenance 
Assurance P1 is also available to stay current with major updates to ConceptDraw Products.  

CROSS-PLATFORM LICENSING 
CS Odessa is one of the only companies in the world that offers a cross-platform license.  A single named user can install 
a purchased license on multiple systems, even with different operating platforms.  

OS X LION SUPPORT 
All ConceptDraw applications are compatible with Macintosh OS X Lion.  

MULTI-DISPLAY SUPPORT 
ConceptDraw MINDMAP v7 supports working across multiple computer screens. You can open separate mind maps on 
different screens and copy-and-paste from one to the other. 

MULTI-LANGUAGE SPELLCHECK 
ConceptDraw MINDMAP offers Spell Check in a variety of different languages. 

ABOUT CS ODESSA 
Founded in 1993, Computer Systems Odessa supplies cross-platform productivity tools and graphics technologies to 
professional and corporate users around the world. From their headquarters in Odessa, Ukraine, and offices in San Jose, 
CA, and Boston, MA, CS Odessa sells internationally in over 150 countries, both directly and through resellers. The 
ConceptDraw Productivity Line has won numerous awards, and is used by hundreds of thousands all over the world. For 
more information, visit http://www.conceptdraw.com/. 

Technical Support/Sales Phone Numbers 

US/Canada/Mexico:  

Technical Support (Toll Free): +1 (877) 441-1150 x4 amersupport@csodessa.com 

http://www.conceptdraw.com/solutions.php
http://www.conceptdraw.com/
mailto:amersupport@csodessa.com
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Sales (Toll Free):   +1 (877) 441-1150 x3  amersales@csodessa.com 

Europe:  

+38 0487601963 support@conceptdraw.com sales@conceptdraw.com 

FREQUENTLY ASKED QUESTIONS 

What is the difference between Technical Support and Maintenance Assurance P1? 

Technical support is a no charge item provided to our customers and individuals trialing or products. Our Tech Support 

team is there to help you with installing, product activation, and product issues.  Technical support is available by 

submitting a ticket via our web site, and by phone and email. Minor product upgrades are at no additional cost. 

When purchased at the same time of you ConceptDraw Product purchase, Maintenance Assurance P1 provides you the 

next major release of your product at no additional cost.  When the next major upgrade of the product becomes 

available you will be notified of its availability for download and installation. 

Why is ConceptDraw Solution Browser part of the product I purchased? 

When you activate a purchased license for your product, that authorization is stored in the cloud, and then synchronized 

with your desktop product(s) using ConceptDraw Solution Browser.  We do this so if the unthinkable occurs and you 

have a catastrophic event with your computer such as a hard disk failure, you can log into your account on 

ConceptDraw.com and retrieve your license, saving you time and headaches. 

The ConceptDraw Solution Browser also manages the versioning of all of your products, and give you access to all of the 

additional business solutions found in the ConceptDraw Solution Park. 

I am with a large organization; do you support other methods of installation besides the one I experienced from my 

trial? 

We have additional methods of delivering product to the users in your organization.  Please contact our sales or support 

team for details. 

Do you have pricing for academia and nonprofits? 

Yes, we have aggressive pricing for students, educators and employees of certified nonprofit organizations. Contact our 

sales team for pricing details. 

  

mailto:amersales@csodessa.com
mailto:support@conceptdraw.com
mailto:sales@conceptdraw.com
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KEYBOARD SHORTCUTS 

Following is an abbreviated list of the most commonly used keyboard shortcuts. See the in-program Help file for the 

comprehensive list. 

Keystroke Function 
Cmd + "?" Help menu 
Cmd + S Save the active document 
Cmd + O Open a Document 
Cmd + N Create a New Document 
Cmd + P Print the active map 
Cmd+A Select all the objects on page 
Cmd + Z Undo the last operation 
Cmd + X Cut the selection to the Clipboard 
Cmd + C Copy the selection to the Clipboard 
Cmd + V Paste the content from the Clipboard 
Cmd + Right Indent topic (one level deeper) 
Cmd + Left Outdent topic (one level closer to the root) 
Cmd + Down Move topic one line down 
Cmd + Up Move topic one line up 
Cmd + Opt + B Hold Brainstorming session in current document 
F5 Start Presentation Mode 

 


